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MEMORY LINK SLAVE 

Serial Driver 
 Supported version TOP Design Studio V1.4.6.26 or higher 

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the TOP and 

external device. 

 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. Cable table Page 12 

 Describes the cable specifications required for connection. 

5. Supported addresses Page 14 

 Refer to this section to check the addresses which can 

communicate with an external device. 

6. Interrupt function Page 15 

 Describes how the TOP sends Interrupt Output message to the 

external device. 
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1. System configuration 

The system configuration of TOP and Memory Link Slave communication driver is as follows: 

 

Series Link I/F 
Communication 

method 
System setting Cable 

- Serial 

RS-232C 3. TOP 

communication 

setting 

4. Cable table RS-422 (4 wire) 

RS-485 (2 wire) 

 

 

■ Connection configuration 

 

ㆍ1:N (one external device and one TOP) connection – configuration which is possible in RS232C/422/485 communication. 
 

                       

 

 

 

ㆍ1:N (one external device and multiple TOPs) connection – configuration which is possible in RS422/485 communication. 
 

                                

 

 

  

External 

Device 

External 

Device 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select Digital Electronics Corporation. 
PLC Select the TOP communication driver. 

 

Model Interface Protocol 

Memory Link Slave Serial Set Users 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 

Supported Protocol 

Memory Link Extended Memory Link 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio.  

 

 

 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C / RS-422 / RS-485 RS-232C / RS-422 / RS-485  

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit NONE  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Project > Project Property > Device Setting > COM > “PLC1 : Memory Link Slave”] 

– Set the options of the Memory Link Slave communication driver in TOP Design Studio. 
 

① Protocol: configured upon selecting Memory Link 
 

 

 

Items Settings Remarks 

Interface Select “Serial”. 2. External device 

selection Protocol Select the communication protocol between the TOP and an external device. 

Interrupt Address Configures the internal address for executing the Interrupt function. 6. Interrupt function 
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② Protocol: configured upon selecting Extended Memory Link 
 

 

 

Items Settings Remarks 

Interface Select “Serial”. 2. External device 

selection Protocol Select the communication protocol between the TOP and an external device. 

Interrupt Address Configures the internal address for executing the Interrupt function. 6. Interrupt function 

Communication Select the communication mode.  

Machine No. Designates the TOP number to be used for communication *Note 1) 

Terminator Selects the frame end code. *Note 2) 

ETX. Sum Check Check whether ETX. Sum Check is used or not.  

ACK Check whether ACK response is used or not.  

NAK Check whether NAK response is used or not.  
 

*Note 1) Activates when communication mode is 1:N. 

*Note 2) Activates when communication mode is ASCII. 
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3.2. Communication setting in TOP 

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 
 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-232C / RS-422 / RS-485 RS-232C / RS-422 / RS-485  

Baud Rate 115200  

Data Bit 8  

Stop Bit 1  

Parity Bit NONE  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

  

① Protocol: configured upon selecting Memory Link 
 

 

 

Items Settings Remarks 

Interface Select “Serial”. 
2. External device 

selection 
Protocol Select the communication protocol between the TOP and an external 

device. 

Interrupt Address Configures the internal address for executing the Interrupt function. 6. Interrupt function 
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② Protocol: configured upon selecting Extended Memory Link 
 

 

 

Items Settings Remarks 

Interface Select “Serial”. 
2. External device 

selection 
Protocol Select the communication protocol between the TOP and an external 

device. 

Interrupt Address Configures the internal address for executing the Interrupt function. 6. Interrupt function 

Communication Select the communication mode.  

Machine No. Designates the TOP number to be used for communication *Note 1) 

Terminator Selects the frame end code. *Note 2) 

ETX. Sum Check Check whether ETX. Sum Check is used or not.  

ACK Check whether ACK response is used or not.  

NAK Check whether NAK response is used or not.  
 

*Note 1) Activates when communication mode is 1:N. 

*Note 2) Activates when communication mode is ASCII. 
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3.3 Communication diagnostics 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.) 
 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1   

 

RD 2 SD 

SD 3 RD 

DTR 4 DTR 

SG 5 SG 

DSR 6 DSR 

RTS 7 RTS 

CTS 8 CTS 

 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA(+) 1  SDA(+)  

 2 SDB(-) 

 3 RDA(+) 

RDB(-) 4 RDB(-) 

SG 5 SG 

SDA(+) 6  

 7 

 8 

SDB(-) 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-485 (1:1 connection) 

COM 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA(+) 1  SDA(+)  

 2 SDB(-) 

 3 RDA(+) 

RDB(-) 4 RDB(-) 

SG 5 SG 

SDA(+) 6  

 7 

 8 

SDB(-) 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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■ RS-485 (1:1 connection) 

COM 

Cable connection 

External device 

Pin arrangement 
Signal 

name 

Signal 

name 
 

 

+  +  

- - 

SG SG 

  

 

■ RS-422 (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP 
Cable connection and signal direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA(+) 

 

SDA(+) 

 

SDA(+) 

RDB(-) SDB(-) SDB(-) 

SDA(+) RDA(+) RDA(+) 

SDB(-) RDB(-) RDB(-) 

SG SG SG 

 

■ RS-485 (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP 
Cable connection and signal direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA(+)  SDA(+)  SDA(+) 

RDB(-) SDB(-) SDB(-) 

SDA(+) RDA(+) RDA(+) 

SDB(-) RDB(-) RDB(-) 

SG SG SG 
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5. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Internal address Bit Address Word Address Remarks 

SYS 00000.00 – 10239.15 00000 – 10239 *Note 1) 

*Note 1) TOP-VIEW can use values between 0 to 102399. 
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6. Interrupt function 

Describes how the TOP carries out the Interrupt Output operation to the external device. 

 

By entering the TOP’s configured internal address into the “Interrupt Address”, the TOP sends an Interrupt Output message to the 

external device. A value lower than 1 byte of the entered value is applied to the Interrupt Output data, where the address resets to 0 

upon sending the message. 


